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1 Introduction 

The Oracle WebCenter Forms Recognition Solution Migration Tool provides a convenient 
method for upgrading an earlier version of the AP Packaged Project to the latest version. While 
the Solution Migration Tool does not automatically upgrade every element of an already-
implemented project, it does drastically reduce the amount of effort required, by allowing 
implementers to easily migrate 'core' project changes from the later version of the project to 
existing project. 

Note: The Solution Migration Tool is provided solely for upgrading the AP Packaged Project, 
and should not be used with any other WebCenter Forms Recognition projects. 

1.1 Definitions    

 Template or Source Project: The project that acts as a template to update all other projects. 

This is typically the latest version of the AP Packaged Project.    

 Target Project: The project that will be overwritten with updates from the template 
project. This is typically the currently implemented version of the AP Packaged Project. 

1.2 Items of Note    

 All in-flight batches should be reprocessed after the AP Packaged Project has been 

migrated using the Solution Migration Tool.    

 It is the responsibility of the implementer to test the migrated project to ensure that 

system performance is not impacted by the update.    

 The Solution Migration Tool does not perform any updates to the project configuration 
(.ini) file. Required updates to the project configuration file must be performed manually. 
See Section 5.3: Update the Project Configuration (.ini) File. 

 The Solution Migration Tool does not perform any updates to the Oracle AP features. 
Required updates must be performed manually. See Section 5: Post Migration Steps for the 
AP Packaged Project. 

 The new Invoice_CN and Invoice_CN2 subclasses for processing Chinese language 
invoices will not be migrated to the source project. It is strongly recommended that 
where multi-byte language documents are being processed, a separate project be used for 
each language. In this case, a new instance of version 1007G of the AP Packaged Project 
should be implemented, which will already include the subclasses mentioned above. 

 The name of the project (.sdp) file and its associated configuration (.ini) file will not be 
changed.  
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2 Migration Items 

This section describes the elements of the AP Packaged Project that will be updated or otherwise 
modified by the Solution Migration Tool. 

Note: If a project element is not explicitly described below it should be assumed that it will 
remain unaltered after being migrated through the Solution Migration Tool. 

2.1 Project Script 

Description Comments 

APPackaged Class This script page is fully encrypted and the tool will be performing a 
full replacement.  

Generic Class This script page is fully encrypted and the tool will be performing a 
full replacement.  

GlobalVariables Class At the bottom of the delivered script there is a section where user 
customizations are permitted to be entered. This is clearly identified in 
the script by the following comments section: 

'================================================== 

'========= GLOBAL VARIABLES CUSTOM EVENTS ========= 

'================================================== 

' 

'================================================== 

'= CUSTOM EVENTS, VARIABLES AND FUNCTIONS SHOULD BE 

'= CREATED BELOW THIS POINT 

'================================================== 

Any script above the comments indicating the user customizations 
area will be flagged as violation by the Solution Migration Tool. Any 
violation has to be removed before upgrade. 

Any script entered in the permitted section, i.e. below the comments 
shown above, will be retained by the Solution Migration Tool. 

Invoices Class At the bottom of the delivered script there is a section where user 
customizations are permitted to be entered. This is clearly identified in 
the script by the following comments section: 

'================================================== 

'========== INVOICES CLASS CUSTOM EVENTS ========== 

'================================================== 

' 

'=============================================== 

'= CUSTOM EVENTS AND FUNCTIONS SHOULD BE CREATED 

'= BELOW THIS POINT 

'=============================================== 

Any script above the comments indicating the user customizations 
area will be flagged as violation by the Solution Migration Tool. Any 
violation has to be removed before upgrade. 

Any script entered in the permitted section, i.e. below the comments 
shown above, will be retained by the Solution Migration Tool. 

UserExits Class The UserExits class script will be updated with new UserExits events 
from the template project. Existing events in this class will not be 
modified by the Solution Migration Tool. 
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2.2 Project Fields 

Description Comments 

New Fields in the Invoices Class  New class fields that exist in the template project will be migrated to 
the target project if they do not already exist.  

Any custom fields in target project will not be removed by the Solution 
Migration Tool. 

Field Settings  All field settings that exist in the template project will be migrated to 
the target project, with the exception of any ASE fields, which will 
remain unaltered by the Solution Migration Tool. 

Table fields should be replaced from the template project.  

2.3 Project Settings 

Description Comments 

Analysis Templates All core analysis templates will be overwritten. Custom templates will 
remain unaltered. 

All new templates will be migrated to the target project.  

Evaluation Templates All core evaluation templates will be overwritten. Custom templates 
will remain unaltered. 

All new templates will be migrated to the target project. 

Validation Templates All core validation templates will be overwritten. Custom templates 
will remain unaltered. 

All new templates will be migrated to the target project. 

OCR Engine / Customization No modification will occur. 

2.4 Learnset Settings 

Description Comments 

Classification Engines Existing classification engine settings will not be modified in the target 
project.   

Classification Learnset No changes will be made to the classification learnset.   

Extraction Learnset for the Invoices Class The extraction learnset for the Invoices class will remain encrypted.  

The extraction learnset from the template project will be copied to the 
target project.  
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3 Pre Migration Steps 

Before migrating the changes from an earlier version of the project to version 1007G of the AP 
Packaged Project, it is essential that the existing project is upgraded and otherwise modified to 
work with the current version of WebCenter Forms Recognition in its current state. 

This section describes the specific pre-migration steps that should be performed for the AP 
Packaged Project. 

3.1 Backup the Project 

Before performing the AP Packaged Project migration, ensure you have a complete backup of the 
project in its current state. The backup should include: 

 The project (.sdp) file. 

 The project configuration (.ini) file. 

 All learnset files and folders (e.g. the Train folder and all its contents). 

 The VendorASSA pool and any other ASE pool data that is used in the project (e.g. the 
Pool folder and all its contents). 

 If the existing implementation uses the file system for batch storage, backup the batch 
root directory and all its contents. 

 If the existing implementation uses a database for batch storage, backup the database.  

3.2 Upgrade the Existing Project in Designer 

Follow these steps to upgrade the existing AP Packaged Project to work with the current version 
of WebCenter Forms Recognition: 

1. Open the existing AP Packaged Project in the Designer application. 

If the existing project uses a version of the FineReader OCR engine that is no longer 
supported by the current version of Forms Recognition you may see the following 
warning message when attempting to open the project: 

Project file could not be loaded! 

Error Description: Cannot load collection item with name "All", because: Zone 

could not be loaded, because a required engine is not installed on this computer. 

Name of this Engine: "FineReader8". 

WebCenter Forms Recognition Designer can try to load the project file once again 

ignoring all errors. This may result in complete or partial loss of project 

information. 

Do you want to retry loading the project file anyway? 

In this case, click Yes to continue loading the project in Designer. 

Note: The project is automatically upgraded when it is opened in Designer. There is no 
visual notification that this has happened. 

2. If the project will be used with the Web Verifier client, it is mandatory that database 
authentication be enabled for the project: 
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a. From the Options menu, select Users, Groups and Roles… The Project 
Authentication Properties dialog is displayed. 

b. On the Project Authentication Properties dialog, ensure that the Allow Database 

Authentication option is checked. 

c. Click the Export to Database… button. A notification is displayed when the 
users, groups and roles are successfully exported to the database. Click OK to 
dismiss this message. 

d. Click the OK button to save the users, groups and roles settings, and close the 
Project Authentication Properties dialog. 

e. When prompted to save the project file, click Yes to save the project and dismiss 
the prompt. 

3. From the Options menu, select Settings. 

4. Select Input Mode tab and change Batch-Root Directory to a valid directory. Create an 
empty Batches directory if it does not exist. 

5. Select Train Mode tab and then select appropriate Learn Set Manager Base Directory to 
a valid directory. Create an empty Train directory if it does not exist. 

6. Switch to Definition Mode by selecting the Definition Mode option from the View 
menu. 

7. In the Classes tree, right-click the project node and select Show Properties from the 
popup menu. The properties pane is displayed on the right-hand side of the Designer 
window. 

8. In the properties pane, click the OCR Settings… button. The OCR Properties dialog is 
displayed. 

9. In the OCR Properties dialog, select the Recognition tab. 

10. Select the required OCR engine from the Available Engines dropdown. FineReader11 is 
the recommended engine for version 1007G of the AP Packaged Project. 

11. Ensure that the Use as Default Engine option is checked. 

12. Click OK to save the OCR settings and close the OCR Properties dialog. 

13. Save the project. 

3.3 Replace the Template Classification Engine 

Projects that were created with a version of WebCenter Forms Recognition prior to 11g Release 1 
(11.1.1), for example, version 1006D of the AP Packaged Project, used the Template Classification 
Engine as the default classification for Supervised Learning Workflow. That classification engine 
is no longer supported, and has been superseded by the Brainware Layout Classification Engine. 

If the existing project contains any classes or subclasses that previously used the Template 
Classification Engine, those classes must be updated to use the Brainware Layout Classification 
engine, and the project must be re-learned, before performing the project migration. 

1. Open the existing AP Packaged Project in the Designer application and switch to 
Definition Mode. 
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2. In the Classes tree, select the first class or vendor subclass that previously used the 
Template Classification Engine. Right-click the class and select Show Properties from the 
popup menu. 

3. On the properties pane, select the Classification tab. 

4. In the list of Used Classification Engines for This DocClass, check the box for Brainware 

Layout Classification. 

5. Repeat steps 2 to 4 for every class or vendor subclass that previously used the Template 
Classification Engine. 

6. Switch to Document Selection Mode and use the Learn Set input mode. To do this, click 
the dropdown arrow beside the Switch to Document Input Selection toolbar button, and 
select Learn Set from the dropdown menu. 

7. Select the first class or vendor subclass in the Learn Set tree that previously used the 
Template Classification Engine. Right-click the class or vendor subclass and ensure that 
the View Classification Learn Set option is checked in the popup menu. 

8. For every document listed in the bottom pane, check the box in the Brainware Layout 

Classification column. 

9. Repeat steps 7 and 8 for every class or vendor subclass that previously used the Template 
Classification Engine. 

10. Switch to Definition Mode. 

11. Re-learn the upgraded project by selecting the Learn Documents option from the Run 
menu. 

12. When learning is complete, save the project. 

3.4 Perform Project Analysis 

Analyzing the current project by the Solution Migration Tool ensures that it is ready for upgrade. 
If there is any error or violation is reported, then it has to be fixed. 

1. Start the Solution Migration Tool as an Administrator using the option Run As 
Administrator. 

2. Import package either Invoices 1006D.zip or Invoices 1007CA.zip using the menu 
option. Refer to Solution Migration Tool User Guide for more information. 

3. Click the Select Source Project button for the Source Project, then browse to and select it.  

Note:  The existing AP Project will be scanned for any issues. Please resolve any item 
flagged in red color. 

4. Fix the Custom Script Violation as mentioned either in the Section 3.4.1 or Section 3.4.2 
below as per the current AP Packaged Project version. 

3.4.1 Fix Script Violation (1006D Only) 

1. Open the existing AP Packaged Project in the Designer application. 

2. Right click GlobalVariables and select Show Script. This will open Script View 
window. 

3. Click Macro and then End to end the script debugger. 
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4. Select fnWriteXMLField on the Proc: drop down on the right hand side. 
5. Replace the function with the following code: 

  Public Function fnWriteXMLField(strAttribute As String, ByVal strValue As String) 

As String 

 

  Dim lngArray As Long 

  Dim blFound As Boolean 

  Dim bytConvert() As Byte 

  Dim strOutput As String 

  Dim intCounter As Integer 

 

  blFound = False 

 

  bytConvert = strValue 'Convert the string value to bytes for comparison 

 

  For intCounter = 0 To UBound(bytConvert) Step 2 

    If bytConvert(intCounter) >= 32 And bytConvert(intCounter) <= 126 Then 

'Printable ASCII characters should be in the range of 32-126 

      strOutput = strOutput & Chr(bytConvert(intCounter)) 'If printable, add to 

output String 

    Else 

      strOutput = strOutput 'If not a printable char, do not add to output string 

    End If 

  Next intCounter 

 

  strValue = strOutput 

  strValue = Replace(strValue, "</", "") 

  strValue = Replace(strValue, "/>", "") 

  strValue = Replace(strValue, ">", "") 

  strValue = Replace(strValue, "<", "") 

  strValue = Replace(strValue, "&", "") 

  If DicVal("XML" & strAttribute, "EXP") <> "" Then 

    If Left(strAttribute, 2) = "HC" Then 

      For lngArray = 1 To UBound(XMLArray) 

        If Left(XMLArray(lngArray), Len("<" & DicVal("XML" & strAttribute, "EXP") & 

">")) = "<" & DicVal("XML" & strAttribute, "EXP") & ">" Then 

          XMLArray(lngArray) = "<" & DicVal("XML" & strAttribute, "EXP") & ">" & 

strValue & "</" & DicVal("XML" & strAttribute, "EXP") & ">" 

          blFound = True 

          Exit For 

        End If 

 

      Next lngArray 

    End If 

    If Not blFound Then 

      ReDim Preserve XMLArray(UBound(XMLArray)+1) 

      XMLArray(UBound(XMLArray)) = "<" & DicVal("XML" & strAttribute, "EXP") & ">" 

& strValue & "</" & DicVal("XML" & strAttribute, "EXP") & ">" 

    End If 

  End If 

End Function 

6. Select fnEscapeXMLOutput from the Proc: drop down and delete this function. 

Public Function fnEscapeXMLOutput(ByVal pstrOriginal As String) As String 

… 

… 

… 

End Function 

7. Close the Script View window and Save the Project. 
8. Close the Designer application. 

3.4.2 Fix Script Violation (1007CA Only) 

1. Open the existing AP Packaged Project in the Designer application. 

2. Right click GlobalVariables and select Show Script. This will open Script View 
window. 
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3. Click Macro and then End to end the script debugger. 
4. Select fnWriteXMLField on the Proc: drop down on the right hand side. 
5. Replace the function with the following code: 

  Public Function fnWriteXMLField(strAttribute As String, ByVal strValue As String) 

As String 

  Dim lngArray As Long 

  Dim blFound As Boolean 

  Dim strOutput As String 

  blFound = False 

  strOutput = fnCleanStringForFlatFileOutput(strValue) 

  strOutput = Replace(strOutput, "</", "") 

  strOutput = Replace(strOutput, "/>", "") 

  strOutput = Replace(strOutput, ">", "") 

  strOutput = Replace(strOutput, "<", "") 

  strOutput = Replace(strOutput, "&", "") 

  If DicVal("XML" & strAttribute, "EXP") <> "" Then 

 

 

    If Left(strAttribute, 2) = "HC" Then 

      For lngArray = 1 To UBound(XMLArray) 

        If Left(XMLArray(lngArray), Len("<" & DicVal("XML" & strAttribute, "EXP") & 

">")) = "<" & DicVal("XML" & strAttribute, "EXP") & ">" Then 

          XMLArray(lngArray) = "<" & DicVal("XML" & strAttribute, "EXP") & ">" & 

strOutput & "</" & DicVal("XML" & strAttribute, "EXP") & ">" 

          blFound = True 

          Exit For 

        End If 

      Next lngArray 

    End If 

    If Not blFound Then 

      ReDim Preserve XMLArray(UBound(XMLArray)+1) 

      XMLArray(UBound(XMLArray)) = "<" & DicVal("XML" & strAttribute, "EXP") & ">" 

& strOutput & "</" & DicVal("XML" & strAttribute, "EXP") & ">" 

    End If 

  End If 

End Function 

6. Select fnEscapeXMLOutput from the Proc: drop down and delete this function. 

Public Function fnEscapeXMLOutput(ByVal pstrOriginal As String) As String 

… 

… 

… 

End Function 

7. Click tab 4 just below the Object: General drop down list on the left side, on mouseover 
it will show the UserExits tooltip and after clicking, the window title will change to 
Script View for Document Class “UserExits”.  

8. Replace the line [13] which says  '#include "OracleAP" with the following line: 
'#include "GlobalVariables" 

9. Click Edit and then select Find [Ctrl] + [F] to find the all the occurrences of the string wfr 
and comment those lines, usually prefixed the line with single quote ('). 

10. Close the Script View window and Save the Project. 
11. Close the Designer application. 

 

 



Oracle WebCenter Forms Recognition 12 AP Project Migration Guide 

4 Performing the Project Migration 

Follow the steps below to perform the project migration: 

1. Start the Solution Migration Tool as an Administrator using the option Run As 
Administrator. 

2. Import package either Invoices 1006D.zip or Invoices 1007CA.zip using the menu 
option. Refer to Solution Migration Tool User Guide for more information. 

3. Click the Select Source Project button for the Source Project, then browse to and select it.  

Note:  The existing AP Project will be scanned for any issues. If there is any item 
flagged in red, Please resolve it before moving on to the next step. 

4. Click Go to migration tab after it is enabled. 

5. Click the Select Template Project button for the Template Project, then browse to and 
select the migration template project (.sdp) file. This is typically located at <Installation 
Folder>\Projects\AP 1007G\Global\AP Packaged Project_1007G.sdp 

6. As soon as the template project is selected. The project migration activity will start, and 
when it is completed a confirmation message is displayed. 

7. Click OK to dismiss the confirmation message. 

Note:  Review the log files if there is any error. 

8. Click the Exit application [F10] button to close the Solution Migration Tool. 
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5 Post Migration Steps 

After performing the project upgrade using the Solution Migration Tool, it is necessary to 
manually update the project script as described below. 

5.1 Fix Project 1007G Script Violation 

5.1.1 What is Script Violation? 

A script violation is any custom code that is created above the following comment in 
GlobalVariables script section. That script section is known as protected area, therefore it is 
important that the custom code should move after the following comment which is also known as 
non-protected area. 

'==================================================================== 

'=============== GLOBAL VARIABLES CLASS CUSTOM EVENTS =============== 

'==================================================================== 

' 

'=============================================== 

'= CUSTOM EVENTS, VARIABLES AND FUNCTIONS SHOULD BE 

'= CREATED BELOW THIS POINT 

'=============================================== 

5.1.2 Fix Script Violation 

To avoid any future upgrade issues with the Solution Migration Tool for upcoming AP Project 
versions, it is important to fix the script violations. 

1. Open the upgraded AP Project 1007G in Designer application. 

2. From the View menu, select Definition Mode. 

3. Right click GlobalVariables and select Show Script. This will open Script View 
window. 

4. Click Macro and then End to end the script debugger. 

5. Go to the end of the file and cut the following lines: 

'==================================================================== 

'=============== GLOBAL VARIABLES CLASS CUSTOM EVENTS =============== 

'==================================================================== 

' 

'=============================================== 

'= CUSTOM EVENTS, VARIABLES AND FUNCTIONS SHOULD BE 

'= CREATED BELOW THIS POINT 

'=============================================== 

6. Now click wfrEscapeXMLOutput in Proc: drop down list, and paste the lines (in clipboard) 
above wfrEscapeXMLOutput function. 

7. Search for the string wfrOutputDataType and cut this enum declaration. 

Public Enum wfrOutputDataType 

 

   odtInvoiceHeader = 1 

   odtInvoiceLines = 2 

 

End Enum 
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8. Again paste the lines (in clipboard) below the following lines: 

'= CREATED BELOW THIS POINT 

'===============================================  

9. Click fnWriteXMLField in Proc: drop down list and perform the following steps: 

a. Copy this function body and paste after the wfrEscapeXMLOutput enum. 

b. Rename the current function fnWriteXMLField to wfrFnWriteXMLField. 

10. Click fnWriteXMLField in Proc: drop down list, and perform the following steps: 

a. Uncomment the following lines: 

  'strOutput = Replace(strOutput, "</", "") 

  'strOutput = Replace(strOutput, "/>", "") 

  'strOutput = Replace(strOutput, ">", "") 

  'strOutput = Replace(strOutput, "<", "") 

  'strOutput = Replace(strOutput, "&", "")  

b. Remove the following line: 

strOutput = wfrEscapeXMLOutput(strOutput) 

11. Click fnWriteXMLDateField in Proc: drop down list and perform the following steps: 

a. Copy this function body and paste after wfrFnWriteXMLField function. 

b. Rename the function name to wfrFnWriteXMLDateField. 

c. Change the occurrences of fnWriteXMLField to wfrFnWriteXMLField inside 
wfrFnWriteXMLDateField function. 

12. Open the UserExits class script window and perform the following steps: 

a. Replace all occurrences of fnWriteXMLField with wfrFnWriteXMLField. 

b. Replace all occurrences of fnWriteXMLDateField with wfrFnWriteXMLDateField. 

13. Close the Script View window. 
14. Open Settings [F3] from the Options menu. 
15. Open default AP Project 1007G package project which comes with the Windows Forms 

Recognition Installation in another Designer application window for reference, Open its 
Settings from the Options menu. 

16. Review the upgraded AP Project settings and do changes accordingly as per the default 
AP Project 1007G. 

17. Save the Upgraded AP Project. 
18. Close both the Designer applications windows. 

Note: To verify if there are no scripting errors, open the Project scripting once again in 
Designer application. Close the application if there are no issues. 

5.2 Remove Reference to the OracleAP Class (1007CA Only) 

Version 1007CA of the AP Packaged Project contains a script-only class called OracleAP, which is 
no longer used in version 1007G. 

Perform the following steps to remove the reference to this deprecated class from the project 
script: 

1. Open the upgraded project in the Designer application. 
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Note: It is to be expected that when you open the upgraded project in the Designer 
application and switch to Definition Mode you will be notified of script errors. 
When prompted to debug the script code, click Yes. 

2. Open the UserExits class script window. 

3. Select (General) from the Object dropdown, then select (declarations) from the Proc 
dropdown at the top of the script window. 

4. Locate the following script line. This will be on or around line 14 of the script: 

'#include "OracleAP" 

5. Modify the script line to replace OracleAP with GlobalVariables, as shown below: 

'#include "GlobalVariables" 

Note: It is necessary to retain the apostrophe character at the start of the script line. 
While this may appear to be a code comment, this is the correct syntax. 

6. Close the script window. 

7. Delete the OracleAP class from the project. To do this, select it in the Classes tree in the 
main Designer window, then right-click and select Delete DocClass from the popup 
menu. 

8. Save the project. 

5.3 Update the Project Configuration (.ini) File 

The project configuration file for version 1007G of the AP Packaged Project contains updated and 
new entries to support the updated project. The Solution Migration Tool does not update the 
project configuration file, so it is necessary for all required modifications to the file to be 
performed manually. 

Refer to the AP Packaged Project Release Notes document for full details of the new and updated 
configuration settings, and ensure that the configuration file for the upgraded project is amended 
accordingly. 


